
Design Guide: TIDA-010087
100A 双相数字控制电池测试仪参考设计

说明

该参考设计阐述了一种使用 C2000TM 微控制器 (MCU) 
和精密 ADC ADS131M08 来精确控制双向交错式降压

转换器功率级电流和电压的方法。此设计利用 C2000 
MCU 的高分辨率脉宽调制 (PWM) 生成外设，实现了

低于 ±20mA 的电流调节误差和 ±1mV 的电压调节误

差。

资源
TIDA-010087 设计文件夹

TMS320F280039 产品文件夹

ADS131M08、REF35、INA188 产品文件夹

OPA2182、LM321LV、TLV9102、
UCC27211

产品文件夹

CSD17556Q5B、CSD16570Q5B、
LMR54410

产品文件夹

TPSI3050、TVS0500、TPS7A20 产品文件夹

TLV1117、LM2664、TPS736 产品文件夹

C2000WARE-DIGITALPOWER-SDK 工具文件夹

请咨询我司 TI E2E™ 支持专家

特性

• 双相交错式 600W 双向降压功率级

• 在 100kHz 开关频率下具有 15.8 位 PWM 分辨率

• 外部 Δ-Σ ADC，可实现闭环控制

• 恒流充电和放电，调节误差 <±20mA
• 充电和放电时均支持恒压模式，调节误差 < ±1mV
• 软件频率响应分析器 (SFRA) 和补偿设计器便于控

制环路调优
• 提供 powerSUITE 支持，以使设计轻松满足用户要

求

应用

• 电芯化成和测试设备
• 可编程直流电源
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1 系统说明

电池测试仪设备包括各种用于测试单个电芯、电池模块和高压电池包的设备。测试设备包含精密电源和数据采集
系统，用于给电池充电和放电，并可测量电芯的各种参数。

图 1-1 显示简化的锂离子电池制造工艺。最后阶段是下线调节，其中包括电芯化成和测试。化成是锂离子电池制

造中的关键一步。在化成过程中，电芯会经历初始充电和放电的过程，从而形成固体电解质界面 (SEI) 层。SEI 层
的质量影响电芯的容量和可靠性。为了控制化成过程，请使用精确的可编程电源对电芯进行充电和放电。这些电

源称为电池化成系统或电池测试仪。电池测试仪所需的电压和电流精度通常在满量程的 ±0.02% 至 ±0.05% 之
间。
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图 1-1. 简化的锂离子电池制造工艺

1.1 关键系统规格

参数 规格

LV 端口 – 电池端口 50 mV 至 6 V

HV 端口 - 总线电压 12V 至 15V

最大输出电流 ± 100A

每相最大直流电流 ±50A

相位数 2

开关频率 93.75 kHz

电流调节误差 < ±20mA (0.02% FS)

电压调节误差 < ±1mV (0.02% FS)
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2 系统概述

2.1 方框图

图 2-1 是参考设计的方框图。TMS320F280039 MCU 为同步降压功率级生成高分辨率 16 位 PWM，并执行电流

和电压控制功能。INA188 仪表放大器检测电流，而 OPA2182 运算放大器检测电压。电流和电压信号由外部 

ADS131M08 ADC 转换为数字数据。C2000 片上窗口比较器用于实现过流电流保护。
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图 2-1. TIDA-010087 方框图

2.2 设计注意事项

2.2.1 电流和电压控制器

图 2-2 显示了电流和电压控制环路的软件实现。电压环路与电流级联，以便在充电和放电模式下实现恒流和恒

压。当电池电压远离恒压设置 (VSET) 时，电压环路饱和至恒流设置 (ISET)。当电池电压接近 VSET 时，电压环

路闭合，并且 ISET 减少以确保电池电压不超过 VSET 限值。该控制器可在充电和放电模式下工作。在充电模式

下，VSET 限制最大电池电压，从而停止充电。在放电模式下，VSET 限制旨在停止放电的最小电池电压。
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图 2-2. 电流和电压控制器

2.2.2 高分辨率 PWM 生成

为了生成高分辨率，使用具有高分辨率 PWM 输出能力的 C2000。高分辨率计数器能够实现 150ps 的时间阶跃，
这相当于 100MHz CPU 时钟在 100kHz PWM 频率下的 16 位分辨率。表 2-1 显示不同开关频率下的 PWM 分辨

率。

表 2-1. PWM 和 HRPWM 的 C2000™ MCU 分辨率

PWM
频率

常规分辨率 (PWM) 高分辨率 PWM
100MHz EPWMCLK

(kHz) 位 % 位 %
20 12.3 0.02 18.1 0

50 11 0.05 16.8 0.001

100 10 0.1 15.8 0.002

150 9.5 0.15 15.2 0.003

200 9 0.2 14.8 0.004

250 8.6 0.25 14.4 0.005

2.3 重点产品

2.3.1 TMS320F280039

TMS320F280039 C2000 器件用于控制同步降压功率级。该器件具有八个 HRPWM 通道和四个窗口比较器，足以

控制四个电池测试通道或降压转换器。有关更多信息，请参阅 TMS320F28003x 实时微控制器 数据表。

2.3.2 ADS131M08

ADS131M08 是一款八通道、同步采样、24 位、Δ-Σ 模数转换器 (ADC)，允许的最大采样率高达 32ksps，足以

实现 ±0.01% 的精度和 1kHz 环路带宽。

系统概述 www.ti.com.cn
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3 硬件、软件、测试要求和测试结果

3.1 硬件要求

图 3-1 显示了 TIDA-010087 硬件。TIDA-010087 板需要 F280039C controlCARD 评估模块才能运行。

图 3-1. 电路板概述

3.2 软件要求

该设计软件在适用于 C2000 MCU 的 DigitalPower 软件开发套件 (SDK) (C2000WARE-DIGITALPOWER-SDK) 中
提供，并在 powerSUITE 框架内得到支持。

3.2.1 在 Code Composer Studio 中打开工程

使用以下步骤在 CCS 中启动工程：

1. 从 Code Composer Studio (CCS) 集成开发环境 (IDE) 工具文件夹安装 Code Composer Studio。建议使用版

本 12.3 或更高版本。

2. 通过以下两种方式之一安装 C2000WARE-DIGITALPOWER-SDK：
a. 转至 CCS 并点击 View → Resource Explorer。在 TI Resource Explorer 下，转至 C2000WARE-

DIGITAL-POWER-SDK，然后点击安装按钮。

b. 通过 C2000Ware Digital Power SDK 工具文件夹。

3. 安装完成后，关闭 CCS，然后打开一个新的工作区。CCS 自动检测 powerSUITE。有时必须重新启动 CCS 
才能使更改生效。

备注
默认情况下，powerSUITE 随 SDK 一起安装。

现在，可以使用以下方法之一导入固件工程：

• 使用 Resource Explorer
1. 在 Resource Explorer 中的 C2000WARE-DIGITAL-POWER-SDK 下，点击 powerSUITE → Solution 

Adapter Tool。
2. 从直流/直流部分下提供的设计列表中选择 TIDA-010087。
3. 将显示开发套件页面。用于运行工程的图标显示在顶部栏中。点击 Run Project。
4. 此操作将工程导入到工作区环境中，并显示具有与图 3-2 类似的 GUI 的配置页面。
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5. 如果不显示该 GUI 页面，请参阅 C2000WAREDIGITAL-POWER-SDK 资源浏览器中 powerSUITE 下的

“常见问题解答”部分。
• 直接从解决方案文件夹导入

1. 用户还可以执行以下操作来直接导入工程：进入 CCS 内部以点击 Project → Import CCS Projects，并浏

览到位于 /solutions/tida_010087/f28003x/ccs 中的解决方案文件夹。

2. 出现两个工程规范：一个工程规范带有 powerSUITE，另一个工程规范不带 powerSUITE。点击任一规范

都会创建该工程的一个自包含文件夹，其中包含所有依赖项。

3. 为发现 powerSUITE GUI 限制或希望为生产代码移除 powerSUITE 的客户提供了非 powerSUITE 工程。

4. 本文档将指导用户完成 powerSUITE 工程，但可通过修改 powerSUITE settings.h 文件中的相关 

#defines 并使用非 powerSUITE 工程重复所有步骤，本设计指南对此进行了介绍。

Power Stage Diagram

Project Options

SFRA Enable

Launch SFRA and 

Compensation Designer

图 3-2. 本设计的 powerSUITE 页面

3.2.2 工程结构

图 3-3. 工程结构概览

硬件、软件、测试要求和测试结果 www.ti.com.cn
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图 3-3 显示了工程的总体结构。导入工程后，CCS 内将显示 Project Explorer，如图 3-4 所示。

备注
图 3-4 展示了 F28003x 的工程；不过，如果从 powerSUITE 页面中选择不同的器件，则结构是类似

的。

特定于解决方案并且独立于器件的文件位于 .c/h 中，其中含有核心算法代码。

特定于电路板且特定于器件的文件位于 _hal.c/h 中。该文件由特定于器件的驱动程序组成，以用于运行解决方

案。如果用户想要使用不同的调制方案或不同的器件，除了更改工程中的器件支持文件，用户只需要对这些文件

进行更改。

-main.c 文件包含工程的主要框架。该文件由对电路板和解决方案文件的调用（有助于构建系统框架）以及中断服

务例程 (ISR) 和慢速后台任务组成。

对于该设计，解决方案为 bt2ph。

可通过点击列在 Project Explorer 下的 main.syscfg 文件来打开 powerSUITE 页面。powerSUITE 页面生成 

_settings.h 文件。该文件是由 powerSUITE 页面生成的用于工程编译的唯一 C 文件。用户不得手动修改该文件，
因为每次保存工程时，powerSUITE 都会覆盖更改。_user_settings.h 包含在 _settings.h 中，可用于保留 

powerSUITE 工具范围之外的任何设置，例如 ADC 映射的 #defines、GPIO 等。

_cal.h 文件包含用于电流和电压测量的增益和偏移量值。

Kit.json 和 solution.js 文件由 powerSUITE 在内部使用，不允许用户进行修改。对这些文件进行的任何更改都会导

致工程无法正常运行。

解决方案名称也用作解决方案中使用的所有变量和定义的模块名称。因此，所有变量和函数调用都以 BT2PH 名称

开头（例如，BT2PH_userParam_V_I_ch1）。这种命名规则使用户组合不同的解决方案，同时避免命名冲突。
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Project Name

Settings.h file generated by powerSUITE. 

Generated once the project is built

Include File paths for different components 

in the project

Device Support Files, Driverlib

Local Copy of all the libraries are made in 

the project folder to created a fully 

standalone folder

Target Configuration for debugger 

connection

Solution Specific Files with Board Drivers 

for the solution

JSON file generated and used by 

powerSUITE page (Do not Modify)

powerSUITE GUI Page

JSON file generated and used by 

powerSUITE page (Do not Modify)

.js File used by powerSUITE 

(Do not Modify)

图 3-4. BT2PH 工程的 Project Explorer 视图

BT2PH 工程由三个 ISR（ISR3、ISR4 和 ISR7）组成。ISR1、ISR2、ISR5 和 ISR6 保留供将来使用。

ISR3 用于检测降压转换器的输入电压和电容器电压。ISR3 由 ADCC 转换完成进行触发。ADCC 用于检测转换器

的输入电压和输出电压，以实现直流/直流的软启动。

ISR4 由 ADS131M08 的 DRDY（数据就绪）信号触发。外部 ADC 编程为 15.625kHz 采样率，该采样率设置 ISR 
频率。ISR 运行电流和电压控制环路函数。

ISR7 由 SPI 接收 FIFO 中断来触发。ISR 用于从 FIFO 寄存器中读取外部 ADC 数据。

图 3-5 和图 3-6 显示了 ISR3、ISR4 和 ISR7 所用的时间。三个 ISR 所花费的总时间不到 8µs。对于 15.625kHz 
ISR 频率，ISR 占用 12.5% 的 CPU 资源。

硬件、软件、测试要求和测试结果 www.ti.com.cn
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图 3-5. ISR4 和 ISR7 执行时间测量

图 3-6. ISR4 和 ISR3 执行时间测量
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3.2.3 软件流程图

bt2ph_hal.c/h,  ads131m0x.h, and bt2ph_cal.h files are necessary to run the bt2ph_main.c and bt2ph.h/c

main()

//Psuedo code

//Setup device, init interrupt, cputimer

//Setup analogpinmux

// Setup internal ADC

//Setup clock for external ADC

//Setup HRPWM for the power stage

//Enable phase shift

//Configure comparators for overcurrent protection

//Setup SFRA

//Setup SPI for external ADC

//Configure external ADC

//Initial variables used in the program

//Enable interrupts

//Configure output relay

//Send the first tranmit bytes for the external ADC

bt2ph-main.c

Background Loop

A1-> BT2PH_updateEnable(..),BT2PH_updateReference()

A1-> BT2PH_SFRA_GUI_RUN_COMMS

A3->BT2PH_updateHrpwmMepScaleFactor();

B1->BT2PH_monitorIoutVout();

B2->BT2PH_SFRA_RUN_BACKGROUND();

B3-> BT2PH_HAL_enableRelay

ISR3

Restore Context 

Return

BT2PH_HAL_storedata_VSENSE()

ISR4

Restore Context 

Return

BT2PH_HAL_ExtAdcSendTxFrame();

BT2PH_runPwmIsr();

ISR7

Restore Context 

Return

BT2PH_HAL_ExtAdcRead();

bt2ph.h

Definition of all global variables for the

solution module

BT2PH_initUserVariables();

…

BT2PH_setControlCoeffcients();

…

BT2PH_setupSfraGui();

…

BT2PH_updateEnable();

BT2PH_updateEnable();

BT2PH_updateReference();

Declaration of all global variables for the

solution module

BT2PH_dcmStartup();

BT2PH_controlCC();

BT2PH_controlCV();

BT2PH_storedataExtAdc();

BT2PH_updateHrpwmMepScaleFactor();

bt2ph.c

Return

BT2PH_storedataExtAdc();

…

BT2PH_controlCC();

….

BT2PH_controlCV();

…

BT2PH_runPwmIsr()

图 3-7. 软件流程图
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3.3 测试设置

3.3.1 用于对电流和电压环路进行调优的硬件设置

TIDA-010087

V_HV Battery Port

10 m�

(Shorted to GND)
DC Source

(12 V – V)

图 3-8. 用于对电流和电压环路进行调优的硬件设置

3.3.2 用于测试双向功率流的硬件设置

TIDA-010087

DC Source

12 V to 15 V

E-load

CC Mode

DC Source

0 V to 5 V

E-load

CC Mode

12-V Bus Battery Port

图 3-9. 用于测试双向功率流的硬件设置

3.3.3 用于电流和电压校准的硬件设置

TIDA-BOARD

DC Source

12 V to 15 V

E-load

CC Mode

12-V Bus Battery Port

6 ½ Digit DMM

Current Measurement

6 ½ Digit DMM

Voltage Measurement

图 3-10. 用于电流和电压校准的硬件设置
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3.4 测试步骤

3.4.1 实验变量定义

BT2PH_userParam_V_I_chx 参数用于在不同的实验中控制功率级。BT2PH_userParam_V_I_ch1 和 

BT2PH_userParam_V_I_ch2 用于实验 1 和实验 2 中，以控制直流/直流转换器的相位 1 和相位 2。实验 3 和实验 

4 使用 BT2PH_userParam_V_I_chm 变量。有关参数定义，请参阅表 3-1。

表 3-1. BT2PH_userParam 定义

BT2PH_userParam 数据类型 注释

iref_A float 设置充电和放电模式的电流 [0，100]

vrefCharge_V float 设置充电模式下的电压 [0，5]

vrefDischarge_V float 设置放电模式下的电压 [0，5]

dir_bool unsigned int
对于充电模式，将此参数设置为 1

对于放电模式，将此参数设置为 0

en_bool unsigned int 将此参数设置为 1 以启用该通道

dutyRef_pu float 开环模式的基准占空比。范围 = 0 至 1.0

ibatCal_pu float 在校准模式下使用此参数设置输出电流。范围 = 0 至 1.0

vbatCal_pu float 在校准模式下使用此参数设置输出电压。范围 = 0 至 1.0

IoutGain_pu float 该变量存储电流增益校准数据

ioutOffset_pu float 该变量存储电流偏移量校准数据

IoutGain_A float 该变量存储电流增益校准数据

IoutOffset_A float 该变量存储电流偏移量校准数据

vbatGain_pu float 该变量存储电压增益校准数据

vbatOffset_pu float 该变量存储电压偏移量校准数据

vbatGain_V float 该变量存储电压增益校准数据

vbatOffset_V float 该变量存储电压偏移量校准数据

3.4.2 实验 1.开环电流控制 - 单相

3.4.2.1 设置实验 1 的软件选项

1. 如节 3.2.1 中所述打开 CCS 工程。如果使用 powerSUITE，请转至步骤 2，否则跳至步骤 3。
2. 打开 SYSCONFIG 页面并在 Build Options 部分下选择：

• 对于“Lab”，选择 Lab 1: Open Loop CC Single Phase。
• 将 Phase Enabled 更改为“Phase 1”或“Phase 2”。

• 将“SFRA Enable/Disable”设置为 1。
• 保存该页面。

3. 当使用非 powerSuite 版本的工程时，直接在 solution_settings.h 文件中修改上述设置。

#define LAB_NUMBER (1)

#define PHASE_NUMBER (1)

#define SFRA_ENABLED (true)
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图 3-11. 实验 1 的构建选项

3.4.2.2 生成和加载工程以及设置调试环境

使用以下步骤来构建和加载工程并设置调试环境。

1. 右键点击工程名称，然后点击 Rebuild Project。
2. 工程成功构建。

3. 在 Project Explorer 中，确保在 targetConfigs 项下将正确的目标配置文件设置为“Active”。

4. 然后，点击 Run → Debug 以启动调试会话。

5. 然后工程加载到器件上，同时 CCS 调试视图变为活动状态。代码在主例程开始时停止。

6. 要在观察/表达窗口中添加变量，请点击 View → Scripting Console 以打开脚本控制台对话框。在该控制台的

右上角，点击 open，然后浏览到位于工程文件夹内的 setupdebugenv_lab1_ch1.js 脚本文件。这将在观察窗

口中填入调试系统所需的合适变量。对于相位 2，选择 setupdebugenv_lab2_ch2.js 脚本文件。

7. 点击观察窗口中的 Continuous Refresh 按钮 ，以持续更新控制器中的值。

3.4.2.3 运行代码

使用以下步骤运行实验 1 的代码。

1. 使用节 3.3.1 中所示的测试设置。

2. 通过点击菜单栏中的  运行工程。

3. 在监视视图中，检查 Expression Window 中 BT2PH_InputVoltageSense_V 是否介于 12V 至 15V 之间。

4. 如果频率为 15.625kHz，则使用示波器检查外部 ADC 的 DRDY 信号。图 3-12 显示了 MCU 运行时 

ADS131M08 的 DRDY 和 CS 信号。

5. 从 Expression Window 中设置以下参数：
• BT2PH_userParam_V_I_ch1->dutyRef_pu = 0.03
• 设置 BT2PH_userParam_V_I_ch1->en_bool = 1
• 将“BT2PH_enableRelay_bool”设置为 1 以启用输出继电器

• 有关“Expression Window”设置，请参阅图 3-13
6. BT2PH_measureMultiphase_V_I 变量显示直流/直流转换器的输出电流和电压。调整 

BT2PH_userParam_V_I_ch1->dutyRef_pu 以确保电流大概为 15A。
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7. 用于开环电流控制的 SFRA 设置显示了用于提取开环电流控制的受控体模型的 SFRA 设置。点击 SysConfig 
页面中的 Run SFRA 图标。此时将弹出 SFRA GUI。

8. 在 SFRA GUI 上选择器件对应的各个选项；例如，对于 F280039，请选择浮点。点击 Setup Connection。在

弹出窗口中，取消选中“boot-on-connect”选项，然后选择合适的 COM 端口。点击“Ok”按钮。返回到 

SFRA GUI，然后点击 Connect 按钮。

9. SFRA GUI 将连接到器件中。现在可以通过点击 Start Sweep 启动 SFRA 扫描。完成完整的 SFRA 扫描需要

几分钟的时间。完成之后，即显示包含测量值的图形，如图 3-15 所示。

10. 频率响应数据保存在工程文件夹的 SFRA 数据文件夹下，并使用 SFRA 运行的时间添加时间戳。

图 3-12. 外部 ADC 的 CSn 和 DRDY 信号
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图 3-13. 实验 1 表达式窗口，开环

Small Duty 

Cycle 2% to 4%

GND

Synchronous Buck

Plant
SFRA Inject Duty

SFRA Collect

S
h
o
rt

ADCIout

图 3-14. 用于开环电流控制的 SFRA 设置
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图 3-15. 电流控制开环频率响应

3.4.3 实验 2.闭环电流控制 - 单相

3.4.3.1 设置实验 2 的软件选项

1. 要运行此实验，请确保按上一节（即节 3.4.2）所述设置硬件。

2. 如节 3.2.1 中所述打开 CCS 工程。如果使用 powerSUITE，请转至步骤 3，否则跳至步骤 4。
3. 打开 SYSCONFIG 页面并在 Build Options 部分下选择：

• 对于“Lab”，选择 Lab 2: Closed Loop CC Single Phase。
• 将 Phase Enabled 更改为“Phase 1”或“Phase 2”。

• 将“SFRA Enable/Disable”设置为 1。

• 通过点击 Run Compensation Design 按钮打开补偿设计器 。

• 然后，补偿设计器启动并提示用户选择有效的 SFRA 数据文件。将实验 1 中运行的 SFRA 数据导入补偿设

计器来设计双极点、双零点补偿器。在此迭代设计过程中保持更大的裕度，以确保环路闭合时，系统是稳

定的。
• 图 3-16 显示了电流环路的补偿参数。

• 点击 Save Comp 按钮以保存补偿。关闭补偿设计器工具。

• 保存 SYSCONFIG 页面。

4. 当使用非 powerSuite 版本的工程时，直接在 solution_settings.h 文件中修改 Build Settings。补偿设计器位于 

C2000Ware_DigitalPower_Install_Location\powerSUITE\source\utils。

#define LAB_NUMBER (2)

#define PHASE_NUMBER (1)

#define SFRA_ENABLED (true)
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图 3-16. 使用补偿设计器对电流环路进行调优

3.4.3.2 生成和加载工程以及设置调试环境

1. 右键点击工程名称，然后点击 Rebuild Project。
2. 工程成功构建。

3. 在 Project Explorer 中，确保在 targetConfigs 项下将正确的目标配置文件设置为“Active”。

4. 然后，点击 Run → Debug 以启动调试会话。

5. 然后工程加载到器件上，同时 CCS 调试视图变为活动状态。代码在主例程开始时停止。

6. 要在观察/表达窗口中添加变量，请点击 View → Scripting Console 以打开脚本控制台对话框。在该控制台的

右上角，点击 open，然后浏览到位于工程文件夹内的 setupdebugenv_lab2_ch1.js 脚本文件。这将在观察窗

口中填入调试系统所需的合适变量。对于相位 2，选择 setupdebugenv_lab2_ch2.js 脚本文件。

7. 点击观察窗口中的 Continuous Refresh 按钮 ，以持续更新控制器中的值。

3.4.3.3 运行代码

1. 要运行此实验，请确保按上一节（即节 3.4.2）所述设置硬件。

2. 通过点击菜单栏中的  运行工程。

3. 在监视视图中，检查 Expression Window 中 BT2PH_InputVoltageSense_V 是否介于 12V 至 15V 之间。

4. 从 Expression Window 中设置以下参数：
• 将 BT2PH_enableRelay_bool 设置为 1 以启用输出继电器。

• BT2PH_userParam_V_I_ch1->iref_A = 15.0。
• 设置 BT2PH_userParam_V_I_ch1->en_bool = 1。
• 有关“Expression Window”设置，请参阅图 3-17。

5. BT2PH_measureMultiphase_V_I 变量显示直流/直流转换器的输出电流和电压。Isense1_A 显示值接近 iref_A 
设置，误差为 ±1mA。

6. 图 3-18 显示了用于测试环路稳定性的 SFRA 设置。点击 SysConfig 页面中的 Run SFRA 图标。此时将弹出 

SFRA GUI。
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7. 在 SFRA GUI 上选择器件对应的各个选项；例如，对于 F280039，请选择浮点。点击“Setup 
Connection”。在弹出窗口中，取消选中“boot-on-connect”选项，然后选择合适的 COM 端口。点击

“Ok”。返回到 SFRA GUI，然后点击 Connect 按钮。

8. SFRA GUI 将连接到器件中。现在可以通过点击 Start Sweep 启动 SFRA 扫描。完整的 SFRA 扫描需要几分

钟才能完成。完成之后，即显示包含测量值的图形，如图 3-19 所示。

9. 频率响应数据保存在工程文件夹的 SFRA 数据文件夹下，并使用 SFRA 运行的时间添加时间戳。

图 3-17. 实验 2 表达式窗口，闭环

GND

Synchronous Buck

Plant
SFRA Inject Duty

SFRA Collect

S
h
o
rt

ADCIout

2-Pole/2-Zero

Compensator

CC Loop

Iset

图 3-18. 用于闭环电流控制的 SFRA 设置
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图 3-19. 电流控制闭环频率响应

3.4.3.4 电流校准

1. 要运行该实验，请确保按节 3.3.3 所示设置硬件。2 点校准方法用于校准增益和偏移量误差。

2. 要测量电流，请使用外部精密电阻器和 DMM，或者您可以使用电子负载电流读数。或者，可以使用 

TIDA-010087 电路板上的检测电阻两端的电压来测量输出电流。

3. 打开 SYSCONFIG 页面并在 Build Options 部分下选择：
• 对于“Lab”，选择 Lab 2: Closed Loop CC Single Phase。
• 将 Phase Enabled 更改为“Phase 1”。

• 将 Calibration Mode 设置为 1 以进行电流校准。

• 保存 SYSCONFIG 页面，并运行代码。

• 打开 Expression Window。

• 使用 BT2PH_userParam_V_I_ch1->ibatCal_pu 参数更新输出电流。

• 将 BT2PH_enableRelay_bool 设置为 1 以启用输出继电器。

• 设置 BT2PH_userParam_V_I_ch1->en_bool = 1。
• 将 BT2PH_userParam_V_I_ch1->ibatCal_pu 设置为“0.05”和“0.3”，并记下输出电流读数。

• 在 bt2ph_cal.h 文件中更新实际输出电流读数。

#define BT2PH_IBAT_ACTUAL_CH1_P1_A ((float32_t)2.6556)

#define BT2PH_IBAT_ACTUAL_CH1_P2_A ((float32_t)16.163)

#define BT2PH_IBAT_ACTUAL_CH2_P1_A ((float32_t)2.6556)

#define BT2PH_IBAT_ACTUAL_CH2_P2_A ((float32_t)16.163)

• 对转换器的相位 2 重复这些步骤。

• 将 Calibration Mode 设置为 0 以禁用校准。

4. 当使用非 powerSuite 版本的工程时，直接在 solution_settings.h 文件中修改 Build Settings。

#define LAB_NUMBER (2)

#define PHASE_NUMBER (1)
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#define CALIBRATION_ENABLED (true)

#define CALIBRATION_MODE (1)

图 3-20. 电流校准的构建选项

3.4.4 实验 3.闭环电流控制 - 双相

3.4.4.1 设置实验 3 的软件选项

1. 使用节 3.3.1 中所示的测试设置。

2. 如节 3.2.1 中所述打开 CCS 工程。如果使用 powerSUITE，请转至步骤 3，否则跳至步骤 4。
3. 打开 SYSCONFIG 页面并在 Build Options 部分下选择：

• 对于“Lab”，选择 Lab 3: Closed-Loop CC Dual Phase。
• 对于双相模式，将 Phase Enabled 更改为 0。
• 将“SFRA Enable/Disable”设置为 1。
• 保存该页面。

4. 当使用非 powerSuite 版本的工程时，直接在 solution_settings.h 文件中修改上述设置。

#define LAB_NUMBER (3)

#define PHASE_NUMBER (0)

#define SFRA_ENABLED (true)

3.4.4.2 生成和加载工程以及设置调试环境

1. 右键点击工程名称，然后点击 Rebuild Project。
2. 工程成功构建。

3. 在 Project Explorer 中，确保在 targetConfigs 项下将正确的目标配置文件设置为“Active”。

4. 然后，点击 Run → Debug 以启动调试会话。

5. 然后工程加载到器件上，同时 CCS 调试视图变为活动状态。代码在主例程开始时停止。
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6. 要在观察/表达窗口中添加变量，请点击 View → Scripting Console 以打开脚本控制台对话框。在该控制台的

右上角，点击 Open 按钮，然后浏览到位于工程文件夹内的 setupdebugenv_lab3.js 脚本文件。这将在观察窗

口中填入调试系统所需的合适变量。

7. 点击观察窗口中的 Continuous Refresh 按钮 ，以持续更新控制器中的值。

3.4.4.3 运行代码

1. 使用节 3.3.1 中所示的测试设置。

2. 通过点击菜单栏中的  运行工程。

3. 在监视视图中，检查 Expression Window 中 BT2PH_InputVoltageSense_V 是否介于 12V 至 15V 之间。

4. 从 Expression Window 中设置以下参数：
• 将 BT2PH_enableRelay_bool 设置为 1 以启用输出继电器。

• BT2PH_userParam_V_I_chm->iref_A = 15.0。
• 设置 BT2PH_userParam_V_I_ch1->en_bool = 1。
• 有关 Expression Window 设置，请参阅图 3-21。

5. BT2PH_measureMultiphase_V_I 变量显示直流/直流转换器的输出电流和电压。Ibatsense_A 显示值接近 

iref_A，误差为 ±1mA。
6. 图 3-22 显示了用于测量开环电压控制频率响应的 SFRA 设置。

7. 点击 SysConfig 页面中的 Run SFRA 图标。此时将弹出 SFRA GUI
8. 在 SFRA GUI 上选择器件对应的各个选项；例如，对于 F280039，请选择浮点。点击 Setup Connection 按

钮。在弹出窗口中，取消选中“boot-on-connect”选项，然后选择合适的 COM 端口。点击“Ok”。返回到 

SFRA GUI，然后点击 Connect 按钮。

9. SFRA GUI 连接到器件中。现在可以通过点击 Start Sweep 按钮启动 SFRA 扫描。完成完整的 SFRA 扫描需

要几分钟的时间。完成之后，即显示包含测量值的图形，如图 3-23 所示。

10. 频率响应数据保存在工程文件夹的 SFRA 数据文件夹下，并使用 SFRA 运行的时间添加时间戳。
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图 3-21. 实验 3 表达式窗口，闭环

2-Pole/2-Zero

Compensator
Synchronous Buck

Plant
SFRA Inject Duty

SFRA Collect

S
h
o
rt

ADCVout

2-Pole/2-Zero

Compensator

CC Loop

Iset
2-Pole/2-Zero

Compensator

CV Loop

Vset

图 3-22. 用于开环电压控制的 SFRA 设置
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图 3-23. 电压控制开环频率响应

3.4.5 实验 4.闭合电流和电压控制

3.4.5.1 设置实验 4 的软件选项

1. 使用节 3.3.1 中所示的测试设置。

2. 如节 3.2.1 中所述打开 CCS 工程。如果使用 powerSUITE，请转至步骤 3，否则跳至步骤 4。
3. 打开 SYSCONFIG 页面并在 Build Options 部分下选择：

• 对于“Lab”，选择 Lab 4: Closed-Loop CCCV Dual Phase。
• 对于双相运行，将 Phase Enabled 更改为 0。
• 将“SFRA Enable/Disable”设置为 1。

• 通过点击 Run Compensation Design 按钮打开补偿设计器 。

• 然后，补偿设计器启动并提示用户选择有效的 SFRA 数据文件。将实验 1 中运行的 SFRA 数据导入补偿设

计器来设计双极点、双零点补偿器。在此迭代设计过程中保持更大的裕度，以确保环路闭合时，系统是稳

定的。
• 图 3-24 显示了电压环路的补偿参数。

• 点击 Save Comp 按钮以保存补偿。关闭补偿设计器 工具。

• 保存 SYSCONFIG 页面。

4. 当使用非 powerSuite 版本的工程时，直接在 solution_settings.h 文件中修改 Build Settings。补偿设计器 位于 
C2000Ware_DigitalPower_Install_Location\powerSUITE\source\utils

#define LAB_NUMBER (4)

#define PHASE_NUMBER (0)

#define SFRA_ENABLED (true)
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图 3-24. 使用补偿设计器对电压环路进行调优

3.4.5.2 生成和加载工程以及设置调试环境

1. 右键点击工程名称，然后点击 Rebuild Project。
2. 工程成功构建。

3. 在 Project Explorer 中，确保在 targetConfigs 项下将正确的目标配置文件设置为 Active。
4. 然后，点击 Run → Debug 以启动调试会话。

5. 然后工程加载到器件上，同时 CCS 调试视图变为活动状态。代码在主例程开始时停止。

6. 要在观察/表达窗口中添加变量，请点击 View → Scripting Console 以打开脚本控制台对话框。在该控制台的

右上角，点击 open，然后浏览到位于工程文件夹内的 setupdebugenv_lab4.js 脚本文件。这将在观察窗口中

填入调试系统所需的合适变量。

7. 点击观察窗口中的 Continuous Refresh 按钮 ，以持续更新控制器中的值。

3.4.5.3 运行代码

1. 使用节 3.3.1 中所示的测试设置。

2. 通过点击菜单栏中的  运行工程。

3. 在监视视图中，检查 Expression Window 中 BT2PH_InputVoltageSense_V 是否介于 12V 至 15V 之间。

4. 从 Expression Window 中设置以下参数：
• 将 BT2PH_enableRelay_bool 设置为 1 以启用输出继电器。

• BT2PH_userParam_V_I_chm->iref_A = 30.0。
• BT2PH_userParam_V_I_chm->vrefCharge_V = 0.12。
• 设置 BT2PH_userParam_V_I_ch1->en_bool = 1。
• 有关 Expression Window 设置，请参阅图 3-25。

5. BT2PH_measureMultiphase_V_I 变量显示直流/直流转换器的输出电流和电压。Vbatsense_V 显示值接近 

vrefCharge_V，误差为 ±0.5mV。
6. 图 3-26 显示了用于测量闭环电压控制频率响应的 SFRA 设置。

7. 点击 SysConfig 页面中的 Run SFRA 图标。此时将弹出 SFRA GUI
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8. 在 SFRA GUI 上选择器件对应的各个选项；例如，对于 F280039，请选择浮点。点击 Setup Connection 按
钮。在弹出窗口中，取消选中“boot-on-connect”选项，然后选择合适的 COM 端口。点击“Ok”。返回到 

SFRA GUI，然后选择 Connect 按钮。

9. SFRA GUI 将连接到器件中。现在可以通过点击 Start Sweep 按钮启动 SFRA 扫描。完成完整的 SFRA 扫描

需要几分钟的时间。完成之后，即显示包含测量值的图形，如图 3-27 所示。

10. 频率响应数据保存在工程文件夹的 SFRA 数据文件夹下，并使用 SFRA 运行的时间添加时间戳。

图 3-25. 实验 4 表达式窗口，闭环
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图 3-26. 用于闭环电压控制的 SFRA 设置
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图 3-27. 电压控制闭环频率响应

3.4.5.4 电压校准

1. 要运行该实验，请确保按节 3.3.3 所示设置硬件。可以在校准期间关闭电子负载，或者将电子负载电流设置设

为小于 Iref_A，以确保电路处于恒压模式。2 点校准方法用于校准增益和偏移量误差。

2. 要测量电压，请使用 DMM。

3. 打开 SYSCONFIG 页面并在 Build Options 部分下选择：
• 对于“Lab”，选择 Lab 4: Closed-Loop CCCV Dual Phase。
• 对于双相模式，将 Phase Enabled 更改为 0。
• 将 Calibration Mode 设置为 2 以进行电压校准。

• 保存 SYSCONFIG 页面，并运行代码。

• 打开 Expression Window。

• 使用 BT2PH_userParam_V_I_chm->ibatCal_pu 参数更新输出电流。

• 将 BT2PH_enableRelay_bool 设置为 1 以启用输出继电器。

• 设置 BT2PH_userParam_V_I_chm->en_bool = 1。
• 将 BT2PH_userParam_V_I_chm->vbatCal_pu 设置为“0.2”和“0.6”，并记下输出电压读数。

• 在 bt2ph_cal.h 文件中更新实际输出电压读数。

#define BT2PH_VBAT_ACTUAL_CH1_P1_V ((float32_t)1.1995)

#define BT2PH_VBAT_ACTUAL_CH1_P2_V ((float32_t)3.599)

• 将 Calibration Mode 设置为 0 以禁用校准。

4. 当使用非 powerSuite 版本的工程时，直接在 solution_settings.h 文件中修改 Build Settings：

#define LAB_NUMBER (4)

#define PHASE_NUMBER (0)

#define CALIBRATION_ENABLED (true)

#define CALIBRATION_MODE (2)
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图 3-28. 电流校准的构建选项

3.5 测试结果

3.5.1 电流环路负载调节误差

表 3-2. 充电模式下的电流环路负载调节误差

FSR (A) 100
TIDA_010087
ISET (A) 0.1 0.5 1 5 10 20 25 30 39

电子负载 CV 模式 电子负载读数

VSET (V) Iactual (A) Iactual (A) Iactual (A) Iactual (A) Iactual (A) Iactual (A) Iactual (A) Iactual (A) Iactual (A)
1 0.118 0.516 1.015 5.011 10.006 19.996 25.004 30.006 39.009

2 0.117 0.514 1.015 5.012 10.009 20.004 25.003 30.005 39.006

3 0.115 0.513 1.012 5.01 10.007 20.003 25.002 30.003 39.004

4.2 0.112 0.51 1.01 5.008 10.005 20.001 25 30.001 39.001

误差 (mA) 0.018 0.016 0.015 0.012 0.009 0.004 0.004 0.006 0.009

误差 (% FSR) 0.018 0.016 0.015 0.012 0.009 0.004 0.004 0.006 0.009

3.5.2 电压环路负载调节误差

表 3-3. 充电模式下的电压环路负载调节误差

满量程 (V) 6.25

TIDA_010087 VSET (V) 1 2 3 4.2

电子负载 CC 模式

ISET (A) Vactual (V) Vactual (V) Vactual (V) Vactual (V)

1 1.00012 2.00038 3.0002 4.2
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表 3-3. 充电模式下的电压环路负载调节误差 (continued)
10 1.00013 2.00039 3.00022 4.20002

20 1.00018 2.00035 3.00018 4.2

30 1.00012 2.00037 3.0002 4.19998

误差 (mV) 0.00018 0.00039 0.00022 2E-05

误差 (% FSR) 0.00288 0.00624 0.00352 0.00032

3.5.3 无负载时的电压转换

图 3-29. 无负载时的电压转换

3.5.4 启动时的瞬态响应

图 3-30. 启动时的瞬态响应
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3.5.5 双向电流开关时间

图 3-31. 电流转换，充电至放电模式

图 3-32. 电流转换，放电至充电模式
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4 设计和文档支持

4.1 设计文件

4.1.1 原理图

要下载原理图，请参阅 TIDA-010087 中的设计文件。

4.1.2 物料清单

要下载物料清单 (BOM)，请参阅 TIDA-010087 中的设计文件。

4.2 工具与软件

工具

TMDSCNCD280039C F280039C controlCARD 评估模块

软件

CCSTUDIO Code Composer Studio (CCS) 集成开发环境 (IDE)
C2000WARE-DIGITALPOWER-SDK 适用于 C2000™ MCU 的 DigitalPower 软件开发套件 (SDK)。

4.3 文档支持

1. 德州仪器 (TI)，TMS320F28003x 实时微控制器 数据表

2. 德州仪器 (TI)，ADS131M08 8 通道、同步采样、24 位 Δ-Σ ADC 数据表

4.4 支持资源

TI E2E™ 支持论坛是工程师的重要参考资料，可直接从专家获得快速、经过验证的解答和设计帮助。搜索现有解

答或提出自己的问题可获得所需的快速设计帮助。

链接的内容由各个贡献者“按原样”提供。这些内容并不构成 TI 技术规范，并且不一定反映 TI 的观点；请参阅 

TI 的《使用条款》。

4.5 商标
TI E2E™ and C2000™ are trademarks of Texas Instruments.
所有商标均为其各自所有者的财产。

5 关于作者

SHAURY ANAND 是德州仪器 (TI) 的系统工程师，负责开发面向测试和测量应用的参考设计。Shaury 拥有印度

理工学院鲁尔基分校电气工程学士学位（技术学士）。

作者感谢 VICTOR SALOMON 和 OZINO ODHARO 对本参考设计提供的大力支持。
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重要声明和免责声明
TI“按原样”提供技术和可靠性数据（包括数据表）、设计资源（包括参考设计）、应用或其他设计建议、网络工具、安全信息和其他资源，
不保证没有瑕疵且不做出任何明示或暗示的担保，包括但不限于对适销性、某特定用途方面的适用性或不侵犯任何第三方知识产权的暗示担
保。
这些资源可供使用 TI 产品进行设计的熟练开发人员使用。您将自行承担以下全部责任：(1) 针对您的应用选择合适的 TI 产品，(2) 设计、验
证并测试您的应用，(3) 确保您的应用满足相应标准以及任何其他功能安全、信息安全、监管或其他要求。
这些资源如有变更，恕不另行通知。TI 授权您仅可将这些资源用于研发本资源所述的 TI 产品的应用。严禁对这些资源进行其他复制或展示。
您无权使用任何其他 TI 知识产权或任何第三方知识产权。您应全额赔偿因在这些资源的使用中对 TI 及其代表造成的任何索赔、损害、成
本、损失和债务，TI 对此概不负责。
TI 提供的产品受 TI 的销售条款或 ti.com 上其他适用条款/TI 产品随附的其他适用条款的约束。TI 提供这些资源并不会扩展或以其他方式更改 
TI 针对 TI 产品发布的适用的担保或担保免责声明。
TI 反对并拒绝您可能提出的任何其他或不同的条款。IMPORTANT NOTICE

邮寄地址：Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2023，德州仪器 (TI) 公司

https://www.ti.com.cn/zh-cn/legal/terms-conditions/terms-of-sale.html
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